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Have you ever wanted 
to exchange files with a 
Microsoft Office user, but Microsoft Office user, but Microsoft Office
you don’t have MS Office ? 
ThinkFree has a solu-
tion. “The award-winning 
ThinkFree Office is an afford-ThinkFree Office is an afford-ThinkFree Office
able suite of word processing, 
spreadsheet, and presenta-

tion graphics applications. Its powerful, yet 
easy-to-use applications can seamlessly open, 
edit, and save directly to the corresponding 
Microsoft Office file formats like .doc, .xls, Microsoft Office file formats like .doc, .xls, Microsoft Office
and .ppt. ThinkFree Write, Calc and Calc and Calc Show
allow users to effortlessly exchange files with 
friends and co-workers using Microsoft Word, 
Excel and Excel and Excel Powerpoint. Its unique, pure Powerpoint. Its unique, pure Powerpoint Java
architecture enables it to run on Windows or Windows or Windows
Macintosh operating systems. Macintosh operating systems. Macintosh ThinkFree Office
features integrated, Internet-based file sharing 
and storage with end-to-end security.” Janeen 
Pugh, Business Developer for ThinkFree will 
show you how you can work with Office docu-Office docu-Office
ments across platforms without the expense of 
owning Microsoft Office. 0

Friday, April 11th at 7 p.m., Building 300, 
(Anna Rubin Hall), New York Institute of 
Technology, Old Westbury. 

The Internet SIG: Held at the Bethpage Public Library, (516) 931-3907, 
on the third Monday of each month at 7:30 p.m. 
Multimedia SIG:  iMovie 3 new features and finishing the movie in prog-
ress. Held on the third Monday of the month (April 21) at 7:30 p.m. in 
Bernie Flicker’s offices: ABC Industries, 100 Cleveland Avenue, Freeport, 
call (516) 867- 8400, ext. 325 or send Bernie your 
e-mail address to be notified about each meeting.  
SIGs immediately before or after the general meeting:
Beginners SIG: 7 p.m. Fonts in OS 9 and OS X.
MacSkills SIG: StuffIt Deluxe.
DTP/Photoshop SIG: (TBD)
Photography SIG: 6:30 p.m. Bring your camera.

x LIMac meetings, unless other-
wise noted, are held in Building 
300 (Anna Rubin Hall) at the 
New York Institute of Technology 
on Northern Boulevard in Old 
Westbury, L.I.
| In bad weather, call (516) | In bad weather, call (516) |

686-7789.
| The next LIMac board meeting | The next LIMac board meeting |

will be at the Plainedge Library, 
(516) 735-4133, on Wednesday, 
April 16th, at 8 p.m.
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March’s Meeting

www.limac.org

Pay Your 2003 Dues: 
Send your $36 check to: Long Island 
Macintosh Users Group, Post Office Box 2048,
Seaford, New York 11783-0180 or bring it to 
the next meeting! the next meeting! 0

http://www.limac.org
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Deleting Mac OS X :
Mac OS X is not easy Mac OS X is not easy Mac OS X
to remove from a 
computer, but the task 
is not impossible.

If you simply want 
to revert to the operating system that came 
with your computer, you should first copy files, 
folders, e-mail boxes, bookmarks and items 
that you want to keep from the OS X system 

onto another drive. Start up the computer using 
the CD of system software that came with the 
machine, and then reformat the drive with 
Apple’s Drive Setup utility. (This completely 
erases the hard drive.) 

Next, reinstall the operating system that 
came with the computer. Then copy your files 
back to the newly-cleaned operating system.

If you have both a Mac OS X and a Mac OS X and a Mac OS X Mac OS 
9 system on the drive, things are more compli-

cated and, prone to problems. 
Use the Startup Disk option in Startup Disk option in Startup Disk System 

Preferences to restart in Mac OS 9, then move 
the files and folders labeled Library, Users, 
mach, mac_kernel and mach.sym to Trash.

You should also throw out the folder called 
System, but not System Folder, but not System Folder, but not ; and the 
Applications folder – but not the one labeled 
Applications (Mac OS 9).

Mac OS X has many invisible files that you Mac OS X has many invisible files that you Mac OS X

can locate with the Mac’s Find program and Find program and Find
then delete. 

Look for files with extensions like .Trashes, 
.DS_Store, .hidden, bin, cores, dev, etc., sbin, 
tmp, usr, var, vol, private, Network and tmp, usr, var, vol, private, Network and tmp, usr, var, vol, private, Network Volumes. 

Once you have trashed those files, restart 
and rebuild the Mac’s Desktop by holding down 
the Command and Command and Command Option keys.

– J. D. Biersdorfer
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President’s Message

Bill Medlow
President
ArchBill@aol.com

Bradley’s Tech Session
| On a hard drive with two or more parti-
tions, can you use Disk Copy to erase one 
partition?
Disk Copy cannot do this. In Mac OS X, Disk 
Utility can be used as long as you select the 
volume and not the disk it’s on. It cannot erase 
and format as DOS unlike the Erase Disk... 
function in Mac OS 9, OS 9, OS 9 Disk Utility can only 
initialize a whole disk with one partition as 
DOS format. You can restart in Mac OS 9 and OS 9 and OS 9
use Erase Disk... under the special menu to 
erase individual volumes.
| I bought a non-Apple brand fl at panel 
display and it has both analog and digital 
inputs. I have a G4 with two connectors on 
the video card. I fi rst hooked up the analog 
VGA connection and it looks great, but I 
wanted to try the digital connection. I got 
a $40 Belkin adapter cable, tried that and it 
looks the same. Should it?
The monitor must have a DVI port and the 
newer Power Mac G4 has a ADC connector. 
The digital DVI connection should offer a 
clearer signal than the analog VGA connection VGA connection VGA
but the difference may be subtle and only the 
best displays would show a difference on some 
photos and a clarity of text edges. The digital 
interface for fl at panels avoids the digital to 
analog to digital conversion required by a VGA 
connection. So at fi rst glance it should look the 
same. A digital connection usually offers fewer 
resolution and refresh rate choices compared 
to an analog connection. There are no digital 
connections for CRT-based displays with the CRT-based displays with the CRT
exception of Apple’s discontinued 17" Studio 
Display (the one with the fl at glass front and 
the mostly clear rear). If shopping for a new 
LCD display – if your Mac offers a digital 
output – that is preferred, but there are some 
fi ne analog-only fl at panels.
| I have a large partitioned hard drive. The 
smaller partition has iTunes library and I 
want to move the fi les to the larger drive. 
How can I do that?
If you are running Mac OS 9 and OS 9 and OS 9 iTunes 2, 
you might try moving the iTunes Music folder iTunes Music folder iTunes Music
in your iTunes folder in your iTunes folder in your iTunes Documents
folder to the other partition and leave an alias 
behind. Make sure the alias does not have alias
at the end. You can have fi les in both places. 
If you drag fi les or folders from anywhere on 

 TIP!

Macworld Expo 2003. 
At the April meeting, LIMac will be asking for 
volunteers for the upcoming Macworld Expo 
2003 which is planned for July 16 -18 in New 
York City (It still must be confirmed as of this 
writing, however).

For LIMac, the past two years at Macworld 
have been highly successful. We have had fun, 
met many new people, shared a multitude 
of experiences, had the opportunity to reach 
many more Macintosh users on Long Island 
and sucessfully represented LIMac as a group 
of dedicated, fun-loving “Macintoshers.” Our 
successes are a  tribute to all LIMac members, 
especially to our more-than-twenty Expo 
booth volunteers.

Next year, the summer Macworld Expo 
will be moving to Boston. So, for LIMac 
this may be a last opportunity to host the 
User Group booth. We should make this our 
greatest effort and leave Macworld Expo with 
something to remember.

More specific information (although similar 
to last year’s) will be discussed at the April 
meeting – along with any and all ideas that 
you would like to share. 0

Hiding an applica-
tion with a click:
If you use your Mac 
in a business setting, 
you may not want 
to let others know 
you’re loosening up 
a little by playing 
a couple of games. 
So, what do you do 
when they walk into 
your office and find 
you blasting away 
at space aliens? Or 
maybe you have sen-
sitive data onscreen 
that you don’t want 
others to see. Sure, 
you could select the 
Application menu 
and choose the Hide
option, but that 
may take too much 
time. Instead, hold 
down the Option
button and click 
anywhere outside of 
the application. This 
will instantly hide the 
front-most applica-
tion and maybe save 
you a little embar-
rassment.

Protect your Mac from theft with this 
User Group discounted offer!
If your computer is stolen, MacPhoneHome :  
| Secretly tracks and locates your missing | Secretly tracks and locates your missing |

computer anywhere in the world 
| Sends a stealth e-mail message to a pre-| Sends a stealth e-mail message to a pre-|

determined e-mail address of your choice 
containing your computer’s exact location 
| Fast recovery – your computer is returned to | Fast recovery – your computer is returned to |

thru the help of police services and global ISPs 
| No yearly monitoring fee, additional charges | No yearly monitoring fee, additional charges |

| Cannot be removed by unauthorized parties  | Cannot be removed by unauthorized parties  |

| For all Mac systems – desktops | For all Mac systems – desktops | and laptops. and laptops. and
| Classic and | Classic and | OS X included at no extra cost. OS X included at no extra cost. OS X

Normally $29.95 per download/license, 
MUG members order through a hidden web-
page and pay only $19.95, a 33% savings. Go 
to www.brigadoonsoftware.com/purchase.html.
Enter this code: MUG616369 and the price is 
changed to $19.99. Offer expires December 31, 
2003. For LIMac Members only!LIMac Members only!LIM 0

MacResQ has 
launched its 
new nationwide 
repair service for 
Macintosh PowerMac 
and iMac computers. 
The service, known 
as PowerMacResQ, 
will provide Mac 
users throughout 
the US with a source 
for 24-hour repairs 
on their computers. 
The cost of the 
PowerMacResQ pro-
gram is $130, which 
includes the 3-way 
overnight shipping, 
the initial diagnostic 
service, and the 
PowerBox (used to 
ship the computer). 
The company offers 
same day pickup and 
promises 24-hour 
repair turnaround 
for most repairs. The 
cost of repairing 
the computer is not 
included. 

HELP!

Protect your Mac from theft with this 

Bradley Dichter
bdichter@bdichter@bdichter cdr.net

 NEW!

http://www.powermacresq.com/
http://www.brigadoonsoftware.com/purchase.html
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Extracting Text from a PDF:
You can extract text of varying lengths using 
Acrobat 4.0 or later: 
| To extract one or more words on the same 
line, or extract an entire line, use the text select 
tool to select the text, and then copy and paste 
the selection. (Don’t use the touchup text tool, 
which is designed for editing text in a PDF file.) 
| To extract a paragraph or a single column, 
hold down the Control key and use either the Control key and use either the Control

column select tool or the column select tool or the column select tool text select tool to text select tool to text select tool
select the text, and then copy and paste. 
| To extract one or more paragraphs on a single 
page and retain the formatting, use the table/
formatted text select tool. For information about 
setting preferences for the table/formatted text 
select tool, see page 290 of the Acrobat 4.0 
User Guide or page 108 of the Acrobat 5.0 Help. 
| To extract an entire page, choose View > Fit 
In Window, select any tool, choose In Window, select any tool, choose In Window Edit > Select 

All, and then copy and paste. 
Note: When you paste the text, it may not be 
formatted as it was in the PDF file, and you see 
different results in different applications. The 
text’s color, point size, and style are usually 
retained, but its font is usually not retained. 
This is because of the way various applications 
collect information from the system’s clipboard, 
which is where Acrobat copies text.  Also, the  Acrobat copies text.  Also, the  Acrobat
application into which you’re pasting must 

support Rich Text Format (RTF) text from the Rich Text Format (RTF) text from the Rich Text Format
clipboard; if it doesn’t, you’ll receive an error 
message or nothing will happen. Adobe Systems 
has no control over the way different applica-
tions collect information from the system’s 
clipboard, and cannot assist you with achieving 
more consistent results when copying and 
pasting. 0

your hard drives into the iTunes 2 Library 
window, it adds a reference to the fi le without 
making a copy on the startup disk. You can 
also select Add to Library from the Add to Library from the Add to Library File menu. File menu. File
Don’t move the iTunes Music Library fi le. iTunes Music Library fi le. iTunes Music Library
FYI: iTunes 2 can keep track of 2 can keep track of 2 32,000 songs, 
but performance (switching windows) suffers 
when you have many thousands of songs in 
the Library. Mac OS X users with X users with X iTunes 3 can 3 can 3
use the shareware iTunes Library Manager 2.5
or iTunes Library Tool 1.0 to deal with multiple 
playlists. Just one more reason to move to Mac 
OS X – more shareware support. Updates and X – more shareware support. Updates and X
new software for Mac OS 9 is drying up.OS 9 is drying up.OS 9
| What do you mean by the term Classic ?
It refers to the environment within Mac OS 
10 that allows you to run programs compat-10 that allows you to run programs compat-10
ible with Mac OS 9. That is those programs OS 9. That is those programs OS 9
not carbonized to work in either OS 9 or OS 9 or OS 9 10 or 10 or 10
those written with the Cocoa programming 
libraries for native Mac OS 10 only use. You OS 10 only use. You OS 10
may see some application installers use the 
term classic for an installation under Mac OS
8 or 8 or 8 9. Everything from now on will have a 9. Everything from now on will have a 9
Mac OS 10 -oriented terminology as Apple has 
declared Mac OS 9 -only development dead. 
Basically what happens in Mac OS 10 is the OS 10 is the OS 10
operating system realizes what applications are 
Classic Applications and when you fi rst ask the Classic Applications and when you fi rst ask the Classic Applications
system to startup a Classic Application, the 
Classic Startup Application is invoked and you Classic Startup Application is invoked and you Classic Startup Application
will see a window appear which shows the old 
Mac OS 9 startup screen and extension icons OS 9 startup screen and extension icons OS 9
loading in the old fashion. This goes away and 
then the Classic Environment is now available.  Classic Environment is now available.  Classic Environment
More or less, you now have Mac OS 9  run-OS 9  run-OS 9
ning as well. Then the Classic Application
is loaded into the Classic Environment, it’s Classic Environment, it’s Classic Environment
menu bar will replace the Mac OS 10 menu bar OS 10 menu bar OS 10
complete with the old multi-colored Apple in 
the left side of the Menu Bar. The Mac OS 10
Dock will now show  the Dock will now show  the Dock Classic Application’s
icon next to the other icons there with no real 
distinction except that Classic Applications
are not available with high resolution icons. 
Any later Classic Application launches will Classic Application launches will Classic Application
not re-invoke the Classic Startup Application
until you restart or shutdown and startup 
again. You can manually shut down the Classic 
Environment from the Environment from the Environment System Preferences 
Application in the Application in the Application Apple Menu or the Apple Menu or the Apple Menu Dock. 

The Classic Environment is contained in Classic Environment is contained in Classic Environment
your System Folder which on older machines, System Folder which on older machines, System Folder
can be used to startup the Mac as Mac OS 9. OS 9. OS 9
Mac OS 10.2 adds or updates a few resources OS 10.2 adds or updates a few resources OS 10.2
to the Mac OS 9 System Folder for it’s use by System Folder for it’s use by System Folder
that version of Mac OS X . (For a list see OS X . (For a list see OS X http:
//docs.info.apple.com/article.html?artnum=106
963) An older version of Mac OS X on another OS X on another OS X
partition cannot use the same System Folder for System Folder for System Folder
it’s Classic environment. So basically, Classic environment. So basically, Classic Classic
is Mac OS 9 except it has no direct access to OS 9 except it has no direct access to OS 9
hardware and overall, it has a limit of a bit 
less than 128MB of your available memory. 
So you can’t use memory intensive programs 
under the Classic environment. Complicating Classic environment. Complicating Classic
things is the fact that programs running in 
Classic environment may requires more Classic environment may requires more Classic RAM
than they normally would if booted under 
Mac OS 9 – aOS 9 – aOS 9  hassle if you want to run a  – a hassle if you want to run a  – a Classic 
Application off of a Application off of a Application CD-ROM. Also, . Also, Classic 
Applications suffer the old problem where if Applications suffer the old problem where if Applications
one program crashes, all other running Classic 
Applications will be affected, unlike the pro-Applications will be affected, unlike the pro-Applications
tected memory of Mac OS 10 -native programs. 
If you have a Classic Application that requires Classic Application that requires Classic Application
installation from more than one CD, it will fail. 
One other “gotcha” is Classic Applications will Classic Applications will Classic Applications
have problems with the privileges of folders of 
Mac OS X, so it’s best to have a second hard OS X, so it’s best to have a second hard OS X
drive or partition for Classic and it’s applica-Classic and it’s applica-Classic
tions. Another problem is Mac OS 10 doesn’t OS 10 doesn’t OS 10
really support resolutions below 800x600, nor 
256 colors. This could be a major problem 
for many games. Some games may switch the 
display without warning, and you’ll have a real 
problem getting back to where you can work 
again. In general, you can print from a Classic 
Application, but I’ve found that Epson’s classic 
software gets in the way of their Mac OS 10
software, preventing the print job getting to 
the printer. Apple suggest turning off back-
ground printing features in Classic. Network 
laser printers work fi ne from Classic. There are 
no Mac OS X non-Iomega drivers for remov-OS X non-Iomega drivers for remov-OS X
able media, so say goodbye to your MO, SyJet 
or ORB drive. One last item: You should use 
Mac OS 9.2.2 (for use with OS 9.2.2 (for use with OS 9.2.2 Mac OS 10.1 or later)  
as the basis for the Classic Environment. That Classic Environment. That Classic Environment
means all your Classic Applications and Classic Applications and Classic Applications control 
panels have to be compatible with panels have to be compatible with panels Mac OS 
9.2.2, not just Mac OS 9. OS 9. OS 9 0

 TIP!

I turned on the 
printer, it could not 
be selected in the 
Chooser.

This is an Apple 
LaserWriter Select 
360, which is con-
nected using an 
AsanteTalk adapter. 
The adapter lets me 
plug my serial printer 
into it and then an 
Ethernet cable goes 
from the adapter 
to my Ethernet Hub 
which it shares with 
my cable modem.

Anyway, I tried all 
the usual remedies 

– unplugged every-
thing, plugged it 
back in, reinstalled 
the printer driver, 
booted with just the 
Mac OS extensions, Mac OS extensions, Mac OS
etc. I contacted 
Asante and they sug-
gested I unplug my 
AsanteTalk adapter 
and at the same time 
unplug my Ethernet 
cable from my cable 
modem. After one 
minute, turn it back 
on. That worked. It 
took two days, but at 
least I don’t need to 
get my LaserWriter 
repaired as I had 
feared.

Who’s hosting that
printer?
Shared printers are 
color-highlighted in 
the Print Center. If Print Center. If Print Center
there are several 
similarly named 
printers, you can 
check the host com-
puter by selecting 
Columns from the 
View menu.View menu.View

– Paul Taylor, Mac 
Hints & Tips.
paul@mac-hints-
tips.com

Printer care in OS X :
Occasionally I have 
continuous misfeeds 
with my laser printer. 
(It usually shows up 
with smaller stuff, 
like envelopes, or 
heavier papers.) 
I have found if I 
open the cover and 
remove the ink car-
tridges; use a Q-tip 
(lintless is preferable, 
but not necessary) 
that has been damp-
ened with rubbing 
alcohol, and gently 
clean all the rubber 
rollers that I can 
see, it has always 
been a sure-fix to 
problematic paper 
misfeeds.

Someone sug-
gested the alcohol 
would damage the 
rubber rollers. I 
figure that in the 
unlikely event that 
my rollers have to be 
replaced, it’ll still be 
a lot cheaper than 
sending my printer 
in for a service call 
every six months or 
so for them to prob-
ably do the same 
thing that I am doing 
at home!

Can’t select your 
printer in the 
Chooser?
I waited until a week 
before Christmas to 
print my Christmas 
letters and when 

http://docs.info.apple.com/article.html?artnum=106963
http://docs.info.apple.com/article.html?artnum=106963
http://docs.info.apple.com/article.html?artnum=106963
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Max Rechtman
maxlimac
@ optonline.net

User Group News
Nothing is ever simple. We’ve had a copier for 
any number of years. When you reach the stage 
in life that requires sending forms to just about 
everyone for medical reimbursements, returns, 
and all that jazz, a copy machine comes in 
very handy. Well, ours broke. I suppose it 
really retired. It still worked, but so slowly, 
it was hard to believe. Also, the paper feeder 
kept slipping; that is, when it fed the paper at 
all. Besides, we needed a new cartridge and 
the cost of this we determined was more than 
we had originally paid for the copier itself. So 
began an odyssey to find a replacement. But, 
we made a remarkable discovery: no one makes 
a plain, simple, home-style copier. Oh, sure 
– you can buy a multispeed office copier that 
collates, staples, organizes, answers the phone, 
etc., provided you are prepared to pay at least 
two arms and a leg. But nothing like the 
simple copier we had been using.

The best we could find was multifunc-
tional. We bought a Brother Five-in-One that 
faxes black and white, as well as color; copies 
in both black and white and color; serves as an 
inkjet printer; and scans both text and photo-
graphs. It is connected with a USB cable and 
has Mac drivers for OS X –  so it seemed to OS X –  so it seemed to OS X
meet all our needs, including a $30 rebate. 

The next problem occurred when I tried 
to connect it to my Cube. Since I have so 
many items bouncing around on my desk, I 
determined that I really needed additional 
USB ports or a USB hub, which according to 
Brother’s installation instructions, must be 
powered. Luckily, since we belong to LIMac, 
Brad Dichter gave us all the info we needed to 
know and Max Rechtman’s Forum column,  
suggested dealing with Brian Caputo of 
MacWarehouse for good service and prices. 
Thanks to all for all your help. 0 

Assuming that Apple and IDG will resolve 
their differences Macworld Conference & 
Expo will take place at the Javits Center in 
New York on July 14-18. The User Group 
Advisory Board has informed us that they are 
working with IDG World Expo to have special 
user group discounts available: “Registering 
with the Apple user group discount codes 
gets you a terrific deal and demonstrates 
the strength and participation of the Apple 
user group community. This helps make 
great things happen for Apple user groups at 
Macworld.”

Many of our members use Optonline 
as their internet service provider, but are 
not aware that Optonline has a junk mail 
filter called SpamAway. To see the current SpamAway. To see the current SpamAway
status of this filter for your account go to 
www.optonline.net. At the top of the window, 
click Sign In where it says Sign In where it says Sign In Webmail and enter Webmail and enter Webmail
your user ID and password. The Select folder
option will allow you to see what is in your 
inbox folder. The Bulk Mail folder will show Bulk Mail folder will show Bulk Mail
you what has been filtered out. If you have 
never done this before, you will be amazed at 
the number of spam items (of which you are 
not aware) that have been removed for you. 
To change settings, select Options > SpamAway 
Settings. 

I leave, SpamAway off because I am afraid 
that important e-mail might be filtered out. 
Even with SpamAway set in the off posi-SpamAway set in the off posi-SpamAway
tion, a huge amount of junk mail is removed. 
To learn more about SpamAway, go to: SpamAway, go to: SpamAway
www.optonline.net/support, select www.optonline.net/support, select www.optonline.net/support Security and Security and Security
click on Spam Information. 0

To scale a picture 
and its picture box 
proportionately:
Select it with the 
Item tool and press 
Command-M to open Command-M to open Command-M
the Modify dialog Modify dialog Modify
box and click on the 
Picture tab. 

Next, enter a % in 
the Scale Across text 
box to change the 
horizontal scale and 
enter the same % in 
the Scale Down text 
box to change the 
vertical scale. Then 
click OK. The X% 
and Y% fields in the 
Measurements do 
the same thing. 

You can propor-
tionately resize a 
selected picture in 
5% increments by 
pressing Command-
Option-Shift-> or Option-Shift-> or Option-Shift->
Command-Option-
Shift-<.

Have you ever wanted 
to exchange files with a 
Microsoft Office user, but Microsoft Office user, but Microsoft Office
you don’t have MS Office ? 
ThinkFree has a solution.  
Janeen Pugh, Business 
Developer for ThinkFree 
will show you how you can 

work with Office documents across platforms Office documents across platforms Office
without the expense of owning Microsoft Office. 
Friday, April 11th at 7 p.m., Building 300, 
(Anna Rubin Hall), New York Institute of 
Technology, Old Westbury. 

work with Office documents across platforms Office documents across platforms Office

http://www.optonline.net
http://www.optonline.net/support/

